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Welcome to the latest edition of my Monthly Final Cut Studio newsletter for April, 2009.

The goal of this newsletter is to provide information helpful to the professional user 
of Final Cut Pro. This newsletter publishes each month and past issues are now 
available in my store. All software references are to Final Cut Studio 2 unless 
otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll 
find daily tips, latest industry news, and over 450 articles and tutorials to help you 
get the most out of Final Cut!
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WRAP-UP

WELCOME

Happy April!

The 2009 NAB Show is getting closer and we are getting more and more excited! First, because 
it is my favorite trade show and, second, because the Digital Production BuZZ is the Official 
Podcast for the entire event and we are covering it extensively.

Also, I have NEW video tutorials and NAB goodies to introduce to you.

I am completely buried in reader mail -- so this month, I have an EXTENDED Reader Mail 
section in the somewhat forlorn hope I'll catch up on my backlog. 

Note: I get asked periodically about proof-reading and reader questions. I get 
about 250 emails a day and try to answer all of them. If a question has relevance 
to a larger audience I'll add it to a future issue of the newsletter. I often will edit a 
lengthy question for space and clarity - but I tend not to correct spelling or 
punctuation. I also try to proof-read my portion of this newsletter carefully before it 
goes out. But my deadlines are tight and I'm not perfect, so if you see a mistake, 
or want to make a comment, please send me an email - I want each issue to be as 
accurate as we can make it. 

mailto:larry@larryjordan.biz?Subject=Hey, Larry!


Whew! Lots to talk about and plenty to see. So, let's get started.

[ Go to Top. ] 

DIGITAL PRODUCTION BUZZ SELECTED OFFICIAL PODCAST  
OF 2009 NAB SHOW!

Through the hard work of our producer, Cirina Catania, Digital Production BuZZ has been 
selected as the Official Podcast of the 2009 NAB Show this year!

We are delighted!

SYNDICATE NAB ON YOUR WEBSITE - TOTALLY FREE!

Starting April 18, we will be producing seven one-hour Digital Production BuZZ shows - one each 
day - highlighting the best of NAB. As well, we will be producing dozens of five-minute NAB 
Show News Briefs during the week of the show. These will cover breaking news and interviews 
at NAB.

Click here to get more information on syndicating NAB or The BuZZ to your website. FREE!

FREE EXPO TICKETS -- SAVE $150 

If you want to get into the NAB expo for free - we can help. Go to the Expo registration page and 
enter this NAB Source Code: X104 -- you pay nothing to enter NAB. Save $150!

INTERNS NEEDED

If you would like to be part of this effort, and are already planning to be at NAB, email to 
Debbie@larryjordan.biz. She will let you know what we need and see where you can fit.

We will have a fully-functional, networked newsroom, built on the show floor and next to the 
Content Theater! If you want to play with some very cool toys, have an all-access exhibitor pass 
to the largest toy store on the planet, and have your work heard by hundreds of thousands of 
people around the world, let us know.

INTERESTED IN SPONSORSHIPS OR ADVERTISING

If you, or your company, would like to reach tens of thousands of industry professionals around 
the world, we have a limited number of sponsor opportunities still available. To learn more, 
email our producer Cirina Catania. Please act quickly!

To learn more - and stay in touch - visit: www.nabshowbuzz.com! 
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A CAUTIONARY TALE
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Eric Solstein sent me the following story to share with you.

I encountered a most mysterious problem during the rendering of a short film, my 
computer just decided to go to sleep. I woke it up, of course, I needed the render 
for a DVD I had to deliver. This all happened about one third into the render 
thermometer's snail-like crawl, and once awoken, my reliable old G5 tower, the 
last of a noble breed, cranked for only another three or four minutes before it 
conked out again. And again soon after that... and then....

Wiser heads than my own suggested I reinstall the System, or render from a new 
account to diagnose the possibility of "OS Preference File corruption." Neither of 
these measures appealed to me, but I decided to try the less drastic, and so dilly-
dallied, changing the various permissions required to allow a new account to 
access the files of an older one. This tactic ultimately yielded a render only 
interrupted to two brief snoozes, not like the deep catatonia my box had fallen prey 
to earlier. Maybe I was onto something... or maybe not.

The rendered movie file appeared to be all right, so now it was time to squeeze 
out quick fresh DVD from iDVD, my quick, easy DVD-making tool of choice. About 
two hours into this six hour render and burn, iDVD was going through the same 
narcoleptic fits as FTP, and I was the only thing burning. Clearly this was a bigger 
problem than I imagined, and if I was going to have to reinstall my otherwise pretty 
darn reliable Mac OS, I would just have to bite the bullet and do it. But I still felt 
vaguely uncomfortable about the whole thing.

Did I mention that I had recently moved into the hottest apartment in New York 
City? Soon after the move, it was noticed, my computer's fans were a bit noisier 
than in the past... actually, I was blissfully unaware of anything, but my wife had 
made a rather big point of mentioning it. So, I went into that handsome aluminum 
tower and cleaned out a mess of dust. Reverting back to my previous state of 
unawareness immediately upon the self-satisfied completion of computer 
cleansing, I failed to note that the noise had hardly diminished.

Now, with my normally dull senses sharpened by the impending deadline and 
colossal delays I had run up, it dawned on me that there might be a reason it 
sounded like a jumbo jet was taking off beneath my desk. I dived once again into 
the guts of my near-state-of-the-art graphic tool (and near term antique) with a 
mind to solve problems and bust down whatever invisible barriers stood in the way 
of that task. Penetrating more deeply into my Mac's labyrinthian innards than I had 
in less desperate time, I noticed around a plastic corner, a very visible barrier - a 
thick, fuzzy gray blanket of dust, dirt and dander, over the shiny silver louvers that 
defended the entryway to my dual processors. Funny, I couldn't remember seeing 
those louvers before.

Yes, now my computer ran (more) quietly, and no longer spontaneously sleeps. I 
guess I'll be working late tonight, catching up.

Larry adds: Eric, thanks for writing this up. I tend to keep my computer off the floor, but, even so, 
it still gets dusty. I'll make sure to clean it out more often from here on out.

UPDATES - April 2, 2009 

Bob Godnik adds:

The part of Eric's story that I was especially interested in was that iDVD is his 
DVD-making tool of choice. Until recently, I sometimes used iDVD as well, 
depending on my DVD requirements but, usually used Compressor/DSP.

A couple of weeks ago, a videographer friend brought over a miniDV tape with 



some wedding footage on it. He was considering a Mac and just using iLife for 
simplicity. He wanted me to author a few minutes of the tape to DVD and compare 
it to the DVD he made with an old Casablanca editing system (A dedicated 
hardware editor with input and output through SVHS!). I captured a couple of 
minutes in iMovie, exported to Quicktime and authored through iDVD (iLife '09). It 
looked fine..., until we watched his DVD. The iDVD sample was a lot more faded 
and less vibrant than his DVD. The iDVD disc looked "flat" and more film-like than 
video. His DVD looked much closer to what the monitor looked like during the 
capture. I had the "professional quality" setting invoked in iDVD.

Out of curiosity, I then used Compressor to convert the exact same Quicktime 
movie that was used for the iDVD sample. With the "Best Quality 90 min" setting 
the DVD looked much more vibrant and (surprisingly) only slightly better than his 
Casablanca/SVHS to DVD solution. I had previously assumed the "professional 
quality" setting in iDVD ('08 and '09) was the same as the "Best Quality 90 min" 
setting in Compressor but that wasn't the case at all, at least not when working 
with video footage from his miniDV camera.

I looked all over the internet for more ways to tweak the settings in iDVD or if 
anyone else noticed this. I couldn't find an answer. Have you heard of this or ever 
tested iDVD against Compressor/DSP with the same source footage?

Larry replies: Bob, I've always preferred using Compressor for both speed and quality, but have 
never done any "testing." If anyone has additional opinions, I'm happy to share them. 

Ben Balser adds:

I can tell you, as a semi-retired IT engineer, with almost 2 prefessional decades 
behind me, CPUs have come a long way. Used to be, CPUs would physically 
overheat and burn up, bang, dead computer, expensive repair. About ten years 
ago the higher end, hotter running CPUs got thermal protection, that would cause 
them to go into sleep mode, even if the OS is set to never sleep, to cut down on 
heat, and save them from an internal physical melt down (literally). Today, all 
CPUs have this, and speed reduction, built in. 

Thus, if your computer slows down a lot, or sleeps when it shouldn't, or gives 
similar strange symptoms, think about the the temperature of the room it's in, it's 
position in the room as far as air flow, and check the inside for a good cleaning. 
Monthly cleaning out (with compressed air) is a must for computers that run 24/7. 
It not only will save you from the type of situation Eric encountered, but will 
actually prolong the life of the CPU itself, as heat breaks it down faster over time.

Larry replies: Thanks, Ben. It is always good to hear from you. 

[ Go to Top. ] 

NEW VIDEO TRAINING COVERING HD 

Our most popular seminar session, hands-down, was a one-hour discussion of how to pick the 
best hard drive and video format.

I've had lots and lots of requests to turn this into a download and, thanks to the help of Eric Blum 
Productions, we've done just that. These are not Final Cut Pro-specific. Rather, we step back 

http://www.ebproductions.com/
http://www.ebproductions.com/


and look at all the different video formats available - at last count more than 400 - and help you 
decide how to pick the best one for your project.

Introducing: Picking the Right Hard Disk and Video Format.

This six-part, one-hour video tutorial produced specifically for download, is directly taken from my 
recent seminars. 

Part 1: Introduction. This section explains why hard disk speed is just as 
important as hard disk storage, and discusses significant differences between 
FireWire 400, FireWire 800, and SATA, along with little known speed traps in 
FireWire than you need to avoid.

Part 2: Video Formats. This section explains basic video formats, NTSC, PAL, 
and HD. We look at how much space is required to store one hour of video, how 
fast the hard disk needs to be to support the format, and what a dropped frame 
error is actually telling you.

Part 3: Compression. This section explains the difference between I-frame and 
GOP-based compression, and why it makes a difference when producing live 
events, or doing lots of complex rendering. This also explains why setting DVD 
chapter markers is better done before your video is compressed.

Part 4: Bit-depth. Probably nothing perplexes more people than video bit-depth. 
The easiest way to think of this is that bit-depth determines how accurately we can 
represent reality in our video image. This section explains what it means and when 
to care about it in your projects.

Part 5: Sub-sampling. We toss around terms like 4:4:4, 4:2:2, 4:1:1... but what do 
they mean and why should we care? Well, the answer depends upon what you are 
doing. If you are doing green-screen work, you should care a lot - this tutorial 
explains why.

Part 6: Summary. In this final section, I take a look at frame rates and why they 
matter, the differences between progressive and interlaced scanning, and then 
summarize everything we've covered.

If you've heard this in my seminars, this will be a great review.

If you are looking for ways to make your projects output faster, look better, or be easier to work 
with, you need to view this new series of tutorials.

I've spent a year researching this material and finding a way to explain it that doesn't require a 
doctorate in engineering. I'm very pleased with these and hope you are, too.

Each part is $9.99. The entire suite of six is $49.99. 

Click here to see the contents of Part 1. 

Click here for the complete package of all six tutorials -- and SAVE 17%. 

[ Go to Top. ] 

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=104
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=105
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=106
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=107
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=108
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=109
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=104
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=110


EDITING SOUND

Bart Weiss sent this question in:

I have a question about editing sound. When working on a documentary we, of 
course, usually cut down the audio track. STP is great for this, especially with [ its 
ability to edit on the] zero point crossing. That would be the best way to cut the 
synch track down in Final Cut, but if I round trip from FCP to STP and cut tracks 
using the zero-crossing point, the picture comes back out of synch. How can I 
used the zero point editing and get back to FCP in sync.

Larry replies: Bart, thanks for writing.

First, the short answer: you can't.

Now a bit longer explanation. When we edit in Final Cut Pro, all our edits MUST occur where the 
video frame changes. For example, in NTSC, we can only edit 30 times in one second. (For PAL, 
we can only edit 25 times in one second.) To keep this illustration simple, let us ignore all other 
potential frame rates. 

Because it is not possible to edit on the half-frame, quarter-frame or any other partial-frame, all 
edits must occur on frame boundaries. Again, in NTSC, that means every 30th of a second.

However, audio is not recorded using a video frame rate. It is recorded using individual samples 
-- 48,000 of them a second. When we edit audio in Soundtrack Pro, we can edit between any two 
samples -- an amazing amount of precision!

Here's an audio clip loaded into a Soundtrack Pro Audio File project. I've zoomed in so we can 
see the waveform more clearly. As this illustrates, audio is a wave -- areas of high pressure (up) 
and low pressure (down). Or, in electrical terms, the wave measures the change in voltage of an 
audio signal. Positive voltage is up and negative voltage is down.

But notice that heavy gray line in the center, where the cursor is pointing. That's called the "zero-
crossing line." This is the point in a waveform where the audio retains all its frequency (pitch) 
information, but has absolutely no volume. 



If I were to make an edit as indicated by this selected area, I would be editing from an area of 
high pressure/voltage immediately to an area of low pressure/voltage. This will always cause a 
pop or click in the audio at the point of the edit. This is often the case when you edit in FCP 
because our audio edits MUST occur on the video frame boundary. The only way to fix this in 
FCP is to put a quick audio dissolve across the edit. It isn't ideal, but it will minimize the click.

A much better way to work is to edit at the zero crossing.

Soundtrack provides a menu choice that makes that easy. Select Edit > Adjust Selection to 
Zero Crossing. My recommendation is to generally extend it outward. This avoids any possibility 
of a noise intruding into your edit.

Notice what happens to the selected area when we adjust the edit point? It has expanded both 



sides of the edit. Now, if you were to delete that selected area, the edit would be absolutely 
soundless.

This would be an ideal way to edit -- EXCEPT that there is no relation between the zero crossing 
line and frame boundaries. It is entirely possible that the zero crossing line is more than a frame 
away from the selected edit. 

Consequently, while it would be great to edit all video this way, when you are working with sync 
sound, you are best editing inside Final Cut, then trimming your edits in STP during the final 
audio mix. That way, everything stays in sync and you are able to clean up any noisy edits 
without getting out of sync.

I do almost all of my mixes this way and hope to create a video tutorial that illustrates this in the 
next few weeks.

For editing synced audio and video, turn snapping on and make sure that View > Snap To is set 
to Frames, rather than the default of Ruler ticks.

Also, you can use Edit > Move Selection > To Next Video Frame - or - To Previous Video 
Frame to keep everything in alignment.

UPDATE - April 2, 2009 

Bob Demers adds:

FCP does support subframe editing for audio, which is handy for fixing zero 
crossing error. The resolution is 1/100 of a frame. Basically, it involves a shift-drag 
[of the In or Out in the Viewer] to navigate the timeline in the player audio tab. A 
search of the latest manual for "subframe" will lead to a couple pages on the topic.

Larry replies: Bob, you are correct. And you can set audio keyframes within a frame as well. 
However, the problem I have with sub-frame editing is that it is very easy to move this too far. At 
which point the audio will be out of sync, but FCP does not display any red flags. I've never been 
a fan of this technique. 

[ Go to Top. ] 

DIGITAL PRODUCTION BUZZ IS NOW SYNDICATED ON wsRADIO

We are now syndicating the highlights of Digital Production BuZZ each month on wsRADIO. The 
Internet is becoming the future of broadcasting. Now, with wsRADIO and the BuZZ, you have 
one more way to stay current.

The show is updated the second Thursday of each month.

March's show features highlights of our recent overseas tour:

* Ken Hay, CEO of Scottish Screen, Glasgow, Scotland 
* Simon Daniels, CEO of Design for Life, Dublin, Ireland 
* Carl Grinter, Director, Business Development of Rushes Post, London 
* Kieron Seth, Managing Director, Broadcast Video Expo 2009, London 
* Andy King, Head of Technology of the BBC, London



April's show, to be posted April 9, features highlights of the run-up to NAB:

* Chris Brown - Executive VP of the 2009 NAB Show 
* Bob Sitrick - Executive Producer, Content Central 
* Brian Koop, VP of Strategic Planning, STATS 
* Mark Rupert & Liz Langston, Executive Producers, 48-hour Film Project 

You can hear what we are doing on wsRADIO here.

Note: The wsRADIO website is not designed for the Safari web browser -- use 
Firefox instead.

[ Go to Top. ] 

A PERSONAL STORY

Jim sent this story in:

I'm a fairly new user. Quite recently I came across a "funny" that I'd like to share 
so here goes. To try and get up to speed in Final Cut Pro I decided to re-cut a 
small 4 minute piece I had just finished in Avid because I thought I could quickly 
learn equivalent techniques in FCP and then compare alternative strategies that 
FCP employs to achieve the same results. 

Using the same footage from this recent Avid project I exported the digitized clips 
from Avid as a Quicktime movie using the *same as source* option, in this case 
PAL DVC Pro 411 Anamorphic. Meanwhile in FCP I set-up my project and set my 
sequence to PAL DVC Pro Anamorphic and imported. 

After import though, in both the canvas and viewer the clips were non-anamorphic, 
more worryingly, FCP was going to print the sequence squeezed with pillar boxed 
black bars down the side. In the window sizing drop down I made sure the correct 
for aspect ratio mark was on, it was, turning it off of course made the picture 
worse. I then highlighted and right clicked on the clip itself and under clip settings 
> format, discovered that the anamorphic flag was not checked. You can check 
this on or off. Once I'd checked it on the clip and sequence were now displayed 
correctly. 

It makes no difference when exporting from Avid which *Display Aspect Ratio* 
setting you use in fact this may only be an instruction for the Quicktime Player. I 
can only assume that on export from Avid the necessary flag describing the clip as 
anamorphic was missing or is unreadable to FCP. 

It is possible I've missed something so please feel free to point this out.

Larry replies: Thanks for writing! You have discovered the way to tell FCP how to treat the 
footage - clicking the Anamorphic flag.

Because an anamorphic picture has the same number of pixels as a 4:3 image (720 x 480 for 
NTSC or 720 x 576 in the case of PAL), when you import the footage, FCP doesn't always know 
whether it should be 4:3 or 16:9.

You solve this by clicking the Anamorphic flag for the clip and / or the sequence. There are a 
couple places you can change this setting:

http://www.wsradio.com/internet-talk-radio.cfm/shows/Digital-Production-Buzz-Radio.html


* Select the clip, or clips, you want to change in the Browser and scroll to the right 
until you see the Anamorphic column. Check the appropriate row in that column 
to turn 16:9 on.

* Select a clip in the Browser or Timeline and choose Edit > Item Properties > 
Format. Turn on the Anamorphic flag by checking it.

* On footage that you capture, or use log & transfer, the anamorphic flag is set 
automatically.

[ Go to Top. ] 



CLIENT SATISFACTION IS KEY

Paul Grosso, from JPL, sent me the following story which I want to share with you.

I started my non-linear editing on Media100 back in the early 90s. We were one of 
the first Media100 owners in Philly. It was a great alternative to Avid and the 
quality was better. 

We ended up switching to Avid purely because there were no Media100 
freelancers, but plenty of Avid freelancers. Many of them would barter time on our 
Media100 to try and learn it, figuring it would be a new standard. They all 
struggled with it, and Media100 never really got to the level of Avid market 
penetration. 

When I saw FCP v1.x, I knew it would be the Avid rival that we were all waiting for. 
I had to set up my new production company on a much more limited budget so I 
went FCP, and loved it. When I came to JPL in 2001, they were a mix of Avid and 
tape-based linear. We converted to FCP within a few months and never looked 
back. 

Yes, they are all just tools. Can you deliver a good quality product in a timely 
fashion? That is indeed the most important question. But, you would have to rip 
FCP from my bleeding fingers before I would give it up.

Larry adds: Thanks for the story, Paul!

[ Go to Top. ] 

LARRY IS TRAVELING TO NEW ORLEANS!

Louisiana is the third largest film market in the country, and New Orleans is truly its heart. So the 
South Louisiana Final Cut Pro User Groups project has invited me to present my PowerUP 
seminars there. 
 
May 8th and 9th I'll be in the Crescent City with two PowerUP seminars. From ingest through 
editing, finishing, and output, I can help FCP users to bring their skills up a notch, helping them 
achieve a more productive and enjoyable editing experience. Learn how to spend more time with 
creative work, and less with technical issues. 

These New Orleans seminars will take place at Delgado College's City Park campus from 9am to 
5pm both days. The event is being produced by Apple-Certified trainer Ben Balser and 
sponsored by Delgado College and the New Orleans Video Access Center. 

Even better, attendees can join us for a reception on the evening of the 9th, featuring the area's 
top film editors, with a discussion on building Louisiana's post production community. 

This is the first time I've been in Louisiana and one event you don't want to miss! Tuition is $50 
through April 27th, and $60 afterwards. 

For more information and registration, contact Ben Balser at benb@bbalser.com. SLFCPUG is 
south Louisiana's most valuable resource for Final Cut Studio users with chapters in New 
Orleans and Lafayette. More information about SLFCPUG can be found at www.slfcpug.org.

[ Go to Top. ] 
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CBR vs VBR COMPRESSION

Björn Adamski, from MXF4Mac, sent me the following:

Recently, we put together a white paper covering CBR versus VBR compression 
that may be of interest to your readers. As the beginning of this 11-page white 
paper explains:

This technical documentation refers to native, conversion free, and 
fast direct access to various video formats on the basis of the 
Material eXchange Format (MXF). Please note that aspects of 
image quality are not considered, this documentation only focuses 
on file access.

Here's the link:

mxf4mac.com/images/stories/downloads/principles_of_cbr_and_vbr.pdf

Larry replies: Thanks, Björn!

[ Go to Top. ] 

DISK-BASED ARCHIVING

I've spent a lot of time over the last year writing and talking about archiving. While we still don't 
have the perfect solution, one of the products I looked at when I attended the Broadcast Video 
Expo in London last February was MatrixStore from Object Matrix. (www.object-matrix.com)

Nicolas Pearce-Tomenius, from Object Matrix, sent me this link to a blog posting on how 
MatrixStore is being used in Brazil. 

I thought you might find it interesting, too.

www.matrixstore.net/2009/03/18/matrixstore-assists-digital-production-workflows-
in-brazil/

[ Go to Top. ] 

READER MAIL

DEALING WITH 16:9 AND 4:3 ASPECT RATIOS

I've gotten a lot of questions about this issue recently. Each is a variation on what Trent 
Anderson sent in:
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I am producing a documentary, and most of the footage that I have from years 
back, is 4:3., and so recently I have been shooting some interviews, and again, I 
choose to use 4:3 instead of 16:9, so that all of the footage would match up. 
However, I have noticed that most new stuff now, especially if I am going to submit 
it to a film festival, or TV, would prefer 16:9. I have tried to drag the old 4:3 clips 
into the timeline, with the sequence presets to Anamorphic, but still with NTSC 
4:3. I think it looks a little "squished" or stretched. Any suggestions as to how I 
might accomplish this? Thanks so much for any input.

Larry replies: Trent, thanks for your question.

The basic problem is that both 16:9 an d4:3 footage has exactly the same number of pixels in the 
image. The only difference is in the shape of the pixels. 16:9 pixels are short and fat, which 4:3 
pixels are tall and thin. (For the engineers in the audience, allow me some dramatic over-
simplification.)

If you edit 16:9 material into a 4:3 timeline, FCP will always scale the image so that the entire 
image is displayed. (In fact, for EVERY video format, if you edit a larger image into a sequence 
with a smaller image size, FCP will always scale the larger image so that the entire image is 
displayed.)

This means that your 16:9 material will have black bars (called "letter-boxing") and the top and 
bottom of the image.

Since your sequence is already 4:3, you have now created a 4:3 image and could stop there if 
you want the highest possible image quality.

However, some people object to seeing the black bars in their shot. At this point, you can double-
click the image to load it into the viewer and increase the Scale setting. As you scale, you will 
lose a portion of the image on each size. Another problem is that since all video is bit-mapped 
(composed of discreet pixels) as soon as the scale amount EXCEEDS 100%, your image will 
start to get fuzzy, grainy, or blurry. In other words, it starts to look bad.

As long as you don't scale it too much, you can probably get away with it. The amount you can 
get away with varies based upon the quality of the source image, the quality of the images before 
and after it, you personal standards for quality, and other, related factors.

Something similar needs to be done to fit 4:3 material into a 16:9 sequence. 

When you add 4:3 material, FCP squeezes it smaller so that the entire image fits into the frame, 
which adds black bars to the sides (called "pillar-boxing"). You can get the 4:3 image to fit the 
frame by increasing its scale in Motion, but, as before, you will lose a portion of the image -- this 
time at the top and bottom. 

Again, remember that the highest quality you can get from your image is when the scale is set to 
100%. Any more will look fuzzy, and anything less means you are not showing all the detail that's 



there.

UPDATE - April 2, 2009

George Langley adds:

One neat trick with resizing the 16:9 in a 4:3 timeline back up to 100% is that you 
can then add a pan that wasn't in the original footage. (I guess technically is really 
a tracking shot!) 

Just set some keyframes and adjust their horizontal X locations as desired. You 
can go from one edge of the image to the other, or middle out, whatever. Adds 
some interest to the shot, as well as getting everything in that the videographer 
had in their original composition.

(Guess a 4:3 in a 16:9 would subsequently allow you to add a tilt!) 

Larry replies: Thanks for sharing this tip. This technique is the low-cost way of doing a pan-and-
scan on your video. 
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SHOOT SD OR HD FOR THE WEB?

Jennifer Koreny, of Cal State Sacramento, has a great question:

What are the benefits, if any, using High Def cameras for video that will end up on 
the web? We are looking to purchase a few cameras for staff to capture events 
around campus. It’s not something we intend to invest a lot of money in (I’m sure 
you’ve heard about Cal’s budget issues) but is something we’d like to expand on 
our website. We will probably make a few DVD’s of lectures as well.

Larry replies: Jennifer, this is an easy question to ask, and very hard to answer. 

The short answer is that there isn't a LOT of benefit if all you are doing is creating web videos at 
400 x 300. That's well below the resolution of standard-def, much less high-def.

Almost all DVDs, too, are standard-def.

However, since there are very, very few SD cameras being sold today, you'll probably buy high-
def.

My feeling is that if you want the best pictures for the web with the least hassle, shoot 720p HD -- 
JVC or Panasonic make good cameras for this.

Others, I am SURE will have their own opinions - which I am happy to share. But, if it were my 
money, that's what I'd buy.

UPDATE - April 2, 2009 

Steven Ludlow, from Cessna Aricraft, adds:



Regarding shooting HD or SD for the web… I don’t pretend to understand all that 
happens to downconverted footage, but I know from just looking that I get a better 
image for the web when my source is HD than I do when it is SD. I realize pixels 
are pixels…but there is something about the original crispness and detail of HD 
that still looks noticeably better when downcoverted for the web. 

For instance - www.flycessnaforfun.com – I shot this with a combination of an EX3 
and a small Canon HG10)

Larry replies: Thanks for the comment, Steven. 
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CREATING THE RIGHT OFFLINE FORMAT

Paul Fiore writes:

I have a client that is editing a movie trailer from the 94 min HDSR master with a 
frame rate of 23.98.

He wants me to generate a DVCAM with VISTC for him to do the offline edit with 
on his home system, then bring me back the FCP Project to do the online and 
layoff to HDSR.

I plan to make his DV files off line and recapture the shots I need from the HDSR 
tape at HD 10 bit, most likely 4:2:2. I know my system can handle 10 bit HD video 
so that isn't a concern.

So my question is: Once I down-covert to DVCAM I know I'm giving him 29.97 
video to work with. So at what point do I account for this when I'm recapturing the 
HDSR with a frame rate of 23.98?

Am I in for a nightmare or is this workflow correct? Can I offer my client a different 
workflow that is going to make both our lives easier?

Larry replies: This leans toward nightmare - because if you edit 24 fps material at 29.97 fps, 
many of your edits will fall on "false frames" -- frames that don't actually exist in the master.

This makes recapture impossible and truly messes up sync.

You would be MUCH wiser to make DVCPROHD 23.98 fps masters - which is a very easy 
format to edit, even on older G-4 systems using FCP 4. If you have a newer system, convert it to 
ProRes 422. Eitehr format keeps the frame rate and image size constant and will greatly simplify 
the final on-line.

However, I don't do offline editing very often any more. I'm interested in what other readers 
suggest.
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http://www.flycessnaforfun.com/


CREATING MULTIPLE OUTPUT FILES

Jim Mitchell writes:

Your training has been fantastic and I enjoy the newsletter. I am bringing in 10-bit 
uncompressed clips from digibeta through an AJA Io and re-purposing those clips. 
Each clip (and there are thousands) has a unique clip number. I sweeten each clip 
in FCP.

Then, I want to output each clip from FCP in the following formats:

- Output back to digibeta through the AJA with no watermark for archiving 
- Output DV quality of the same clip with no watermark to our on-line server 
- Output MPEG4 of the same clip with a unique water mark to our on-line server 
- Output MPEG4 of the same clip with a 2nd unique water mark to our on-line 
server

In all, each clip gets re-purposed 4 times. 

Question: Is there any sort of batch export that one can do to output all these 
different formats simultaneously or must each format and each unique 
watermarked clip be brought out individually? These uniquely numbered clips 
must be kept separate from one clip to the next but all four formats bear the 
identical clip number for cross reference in the database. This means I can't drag 
them all to the time line and make one big movie. Each clip must remain separate 
and unique unto itself so it can be loaded with its appropriate meta data into the 
database of the server in all the various formats and two watermark configs. What 
would you do?

Larry replies: While you can't do this in one step, you can do it in four:

1.  Output to DigiBeta (i.e. record to tape)
2.  Export a high-res file (i.e. 10-bit uncompressed) to your hard disk using the naming 

convention of your choice. 
3.  Create a droplet in Compressor that creates the three file versions you need: DV and 

MPEG-4, with and without watermark.
4.  You could automate this further using Automator to watch a particular folder and 

automatically start compressing a files as soon as it is done exporting from Final Cut Pro.

The benefit to using Compressor is that it does batch processing, format transcoding, 
watermarking, and FTP transfer all while running the background. 

Here is an article on creating droplets: www.larryjordan.biz/articles/lj_droplet.html

UPDATE - April 2, 2009 

Robert Croy asks:

I have been trying to [follow your step #4] but have the problem that if it is a folder 
action it will fail because the action wants to start as soon as the file is being 
written or downloaded. So how would you do this?

Larry replies: Rob, when I have been working with Automator, I have read that there is a setting 
in Automator that says "wait until file download is complete. But, I am not an Automator kind of 
guy, so while I know it is there, I haven't used it.
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CREATING A FAST-MOTION CLIP

Karen Irvine writes:

One thing you didn't touch on in your training is how to create a fast-motion clip.

Larry replies: There are four ways to change the speed of a clip:

�●     With a freeze frame
�●     With a Fit-to-Fill edit
�●     With a constant speed change effect
�●     With a variable speed change effect

To create a fast motion clip - sort of like a poor-man's time-lapse:

�●     Create a new sequence and edit the clip that you want to turn into a time-lapse clip into it
�●     Select the clip
�●     Choose Modify > Speed
�●     Set the percentage to, say, 900
�●     This is too fast to play properly without dropping frames, so select File > Export > 

QuickTime movie
�●     Export the clip as a self-contained QuickTime movie 
�●     Import that new file and edit it into your sequence.
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SHOOTING VIDEO WITH A DIGITAL STILL CAMERA

John Warner writes (I'm paraphrasing from his letter):

I own the Canon 5D digital still camera. It shoots digital video. How can I use this 
video in Final Cut Pro?

Larry replies: John, you can do this, but it will be a bit of work. 

�●     Transfer the image file to your computer.
�●     Using Compressor, convert it from its native RAW format into ProRes 422 HQ.
�●     Create a ProRes 422 HQ sequence in Final Cut Pro 
�●     Import and edit your footage.

John wrote back:

I assumed that it would require work and be a pain in the rear but I really like the 
idea of using my Canon glass and getting that really really shallow depth of field.

Folks are doing some interesting things:

www.usa.canon.com/dlc/controller?act=GetArticleAct&articleID=2327 
www.slashgear.com/canon-eos-5d-mark-ii-sample-video-clips-1716575/

http://www.usa.canon.com/dlc/controller?act=GetArticleAct&articleID=2327
http://www.slashgear.com/canon-eos-5d-mark-ii-sample-video-clips-1716575/


In my dreams, I would save for the affordable RED consumer camera which 
debuts later this year but the shoot for next week has been approved and I have to 
move quickly.

Larry replies: Thanks for writing!
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AUDIO DRIFT WITH CAPTURE NOW

Frankie Gonzalez writes:

I was following along with your capture lesson and you said never use capture 
now, your audio will drift.

I just purchased a new mic and I was testing it out with my camera. While 
capturing the footage using your method the exact opposite happened.

The audio drifted while using clip. What can I do to fix the problem?

Also I’m getting lots of dropped frames running the footage what can I do.

I have a macbook pro 2.4 GHZ Intel Core Duo and 4 gigs of ram. And external 
hard drive. I should be cruising along.

Larry replies: Thanks for writing!

Make SURE your scratch disks in FCP are set to your external drive. Dropped frames are 
caused by a hard disk that's too slow for what you are recording to it. Often, this indicates your 
scratch disks (Final Cut Pro > System Settings) are pointing to your boot drive. That won't work.

Make SURE your camera is recording audio at 48 kHz, also called 16-bit. Sync drift is often 
caused by the camera recording at the wrong sample rate.

Make sure your external hard drive is NOT attached via USB - that, also, is too slow on the Mac.

Here are some articles that may help further:

�●     Audio sample rates: www.larryjordan.biz/articles/lj_audio_capture_settings_32khz.html
�●     Trouble-shooting: www.larryjordan.biz/articles/lj_trouble.html
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PROTECTING YOUR GEAR

Ken Stone runs a great Final Cut Pro website. If you haven't visited it, you are missing some 
great articles.

http://www.larryjordan.biz/articles/lj_audio_capture_settings_32khz.html
http://www.larryjordan.biz/articles/lj_trouble.html


Recently, Steve Douglas ran a review of an APC Surge Protector. While surge protectors may 
not be high on your list of sexy editing equipment, you owe it to yourself to read this article.

www.kenstone.net/fcp_homepage/apc_surge_arrest_douglas.html

Especially if you want your gear to last longer than the next storm.

For what it's worth, all my computer gear is protected by an APC Back-UPS XS 1500 battery 
backup system. It's worked great, I've never had a computer problem caused by electricity, and it 
works even in the dark.
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SONY HARD DISK RECORDING UNIT TROUBLE

German sent me a question that is all too frequent:

Last december I bought a Sony HVR DR60 hard disk recording unit and I can't 
make it work right with FCP.

I can't transfer videos from the DR60 to Final Cut Pro using "Log and Transfer". I 
have Final cut version 6.0.4 and already downloaded the Plugin from this Sony 
web page. I also updated quick time but I cant get it to work right. 

This is very frustrating. I've spent days trying to find out how to make it work right 
with no success. 

Larry replies: German, thanks for writing, but you are not going to like the answer. The reason 
you can't get it to work is that Final Cut does not support the unit. 

This brings up a REALLY important point: Before buying any new video gear, be sure it works 
with your system. 

You can find out what equipment is supported by visiting the Resources page for Final Cut 
Studio: www.apple.com/finalcutstudio/resources

UPDATE - April 2, 2009 

Jason Boyette sent in this update: 

The HDR-DR60 works very well with FCP 6.0.5. Here's what I do to get it to work:

�●     Connect hard drive (HDR-DR60). Do not turn it on
�●     Open FCP
�●     Shift+Command+ 8 (Opens Log & Transfer)
�●     Turn on the HDR-DR60 (slide to the computer side...not video)
�●     Wait patiently for about 30 sec to a minute
�●     You will then see a thumbnail of each clip
�●     You can't preview them but you can import them and then edit away

I hope this helps, I use these steps every morning at my school doing a daily 
newscast!

http://www.kenstone.net/fcp_homepage/apc_surge_arrest_douglas.html
http://www.apc.com/resource/include/techspec_index.cfm?base_sku=bx1500
http://www.apple.com/finalcutstudio/resources


Thanks for the great newsletter every month and the tutorials on Lynda.com. 
My students always ask how I know the things I do...I always tell them "Larry 
Jordan taught me everything I know"

Larry adds: Thanks, Jason, for sending this in. 

UPDATE - April 3, 2009

Andy Mees adds:

Quick bit of info regarding your reader German's request for help using his Sony 
HVR DR60 recording unit with FCP.

You note that it is not supported and whilst thats absolutely correct, inasmuch as it 
is not on the official support list, it has actually been supported since version FCP 
6.0.3 when used in conjunction with the correct Sony Log and Transfer plugin 
(BPE-SS-038D): www.sony.com.au/objects/Other/HVRDR60/html/soft.html#A2

German notes that he already has the correct software but is having trouble 
getting it to work right ... maybe the workflow guidelines at the link above can help 
him.

Larry replies: Andy, thanks for this.
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WHY DOES EVERYTHING HAVE TO RENDER?

Randall Brown asks:

I'm getting a red render bar on all transitions, even dissolves. I noticed that you 
didn't seem to have this problem in your Lynda.com training. The "option P" 
command also seems to briefly stop in the middle. RT is set for dynamic. 

What's causing the problem.

Larry replies: Randall, thanks for writing. Your MacBook Pro system is plenty fast enough. My 
GUESS is that your sequence settings (Sequence > Settings) don't match your video clips. 
Check there first. 

Note: You can verify what a clip's settings are by selecting the clip, then choosing 
Edit > Item Properties > Format.
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HOW TO AVOID RENDERING STILL IMAGES

Don Kates asks: 

http://www.sony.com.au/objects/Other/HVRDR60/html/soft.html#A2


I'm having a problem with FCP. when I bring images in prepared as you say to do 
(2.5x the frame size), everything I do in the timeline with those images needs 
rendering( i.e.. transition, filter or even a change in length of the transition). Could 
you give me some insight into the problem? If I bring them in at the frame size for 
the sequence 1920 x 1080, i don't have the problem. 

Larry replies: Don, the simplest definition of rendering is to convert an effect or image from its 
native format to match the video format of your timeline. 

When you create an image that is significantly larger than the video format you are using, Final 
Cut renders it, or converts it, from that high-quality image into a form that matches your timeline.

When your image size is, essentially, the same as the timeline, Final Cut can do this in real-time. 
However, if the image is really big, or really small, FCP can't process it quick enough to play in 
real-time, so it needs to render.

The benefit of using images with higher resolution (quality) than your sequence is that you will 
most often end up with a higher quality result in your sequence. However, if time is of the 
essence and you don't need to move around the image, then bring it in at exactly the frame size 
you need for your project. 

�●     For 1080 projects, a full-screen image is 1,920 x 1,080 x 72 pixels.
�●     For 720 projects, a full-screen image is 1,280 x 720 x 72 pixels.

For NTSC and PAL projects, image sizes vary wildly. Here's an article that explains this in more 
detail: www.larryjordan.biz/articles/lj_grfx_look.html.

Keep in mind that all stills, regardless of image size, will requiring rendering before final output or 
export.

Also, keep in mind that FCP does not like images larger than about 4,000 pixels, so if you are 
working at HD resolutions, make your image 3840 x 2160 or smaller. 
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CREATING A STILLS PROJECT

Daniel Carrion writes:

I am a retiree picking up FCP as a hobby and it is being more than challenging this 
for me. I want to make a movie of my daughter’s wedding pictures (2304 x 1536). I 
started this project using the 4.3 format and the truth is that the quality is really 
poor in my HD 37 inches LCD flat TV. And also with just a few pictures I am 
already over 1GB of disk used.

For this project I bought your “Moving on Stills” DVD and following the examples I 
came out with the idea that maybe I should make it a HD movie with the stills or at 
least a format that I could easily convert it to HD later on.

Would you point me in the right direction?

I need to know:

http://www.larryjordan.biz/articles/lj_grfx_look.html


  
  
  
  
  
  
  
  
  
  

�●     Picture sizes ( I imagine 2132 x 1200 is the 16.9 format)
�●     Settings for FCP, DVD SP
�●     Should I buy a blue ray burner for the Windows or for the Mac Pro?

Larry; why don’t you create a “Moving on Still for HD”?

Larry replies: Daniel, without a doubt, working with stills causes headaches for everyone.

First, the key question is how are you going to distribute this video? Blu-ray discs can be created 
on a Mac, but you'll need Toast or Adobe Encore. Final Cut Studio can't do it.

Second, High-Def Blu-ray discs can only be played on an HD TV set.

Third, yes, an HD movie would be better quality than SD. The image problems you are seeing 
are most likely due to down-sampling your image to SD quality (which is very much lower than 
the original image).

Fourth, the video setting I recommend would be either DVCPRO HD 720p/60 or ProRes 422. An 
hour of DVCPRO HD takes 48 GB to store. And hour of ProRes 422 takes about 60 GB to store. 
Neither is small, but the quality is much higher. The reason I recommend 720p is that it can be 
easily displayed to computer screens - which, I suspect, is where more people will view this 
movie, than on Blu-ray discs.

A suggested image size should be 2560 x 1440 x 72 dpi.

Here's an article that can help: www.larryjordan.biz/articles/lj_grfx_look.html
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MOVING FILES BETWEEN FINAL CUT PRO AND PRO TOOLS

Mike Carroll writes:

You interviewed me sometime ago about my first independent feature film Year 
and editing a monthly half-hour show on my 4 year old iBook for broadcast on 
KCRA-TV. 
I'm now finishing my second feature Nightbeats (nightbeats-movie.com). I 
exported my audio files as an OMF for him to import into Pro Tools for a sound 
mix & design.  
He's given me a complete AIF of the mix for the film, but I also asked for an export 
of all the files from his Pro Tools project, that came in a folder with a .PMR file. I'd 
like to open that Pro Tools timeline into Final Cut Pro to do additional tweaking 
and finer editing.

There's lots of articles about exporting from Final Cut for Pro Tools, but how do I 
import Pro Tools projects into Final Cut Pro 6?

Thanks for any direction you can point me toward.

Larry replies: Mike, thanks for checking back in.

First, You can't open OMF files, or ProTools files, in Final Cut. However, if your audio engineer 
exported the files as an OMF, you CAN open them in Soundtrack Pro. FCP only expects the final 

http://www.larryjordan.biz/articles/lj_grfx_look.html


mix as an AIF or WAV file. 

You might also check into the ProTools conversion utility from Automatic Duck: www.
automaticduck.com/products/pifcp/
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SOUNDTRACK PRO TRICK

Tracy Evans sent this in:

I took your course in STP on Lynda a few months ago, and it really helped jump 
start me in using the program. Just wanted to say thanks.

Also, I wanted to mention a problem and solution I just found that you might be 
interested in. I was having trouble with stereo pairs when sending FCP files to 
STP. My stereo pairs were being split on to two tracks in STP. 

The solution was to make sure that stereo tracks in FCP started on odd number 
tracks. A stereo pair on tracks 2-3 in FCP ends up as two tracks in STP. The same 
stereo pair on tracks 3-4 in FCP end up as a proper single stereo track in STP.

You probably already knew this, but I struggled with it for about an hour trying to 
solve it. I searched the web, but did not find anything on it.

Larry replies: I'm really glad you liked the seminars and I've discovered the same trick myself. 
Thanks for sharing this!
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PROBLEMS WITH SOUNDTRACK

Peter Zersch writes:

I saw your Soundtrack pro tutorial (very useful). Immediately I could make use of 
it. But something didn't work out as you described. Maybe you can help.  
 
The problem was. I had a hum in my rough material (all captured as small clips, 
couldn't capture it as a long clip). I exported one clip to test if I could get rid of the 
hum. The hum remover didn't work (analyses did nothing, don't know why) and 
also the noise print/remove noise didn't do a good job (the voices got distorted, 
and the hum was still noticeable).  
 
So I opened the spectrum window (a super feature). And there I decided to get rid 
of a lot of noise in the 150-200 Hz region (selected this range and hit the 
backspace key). This did a superb job. The hum was completely gone and the 
voices in the clip where like nothing had ever happened. So far so good, but then I 
wanted to repeat this this action on all my other clips (which was a lot of clips). 
Because it would take me hours to do this same action for all these clips I decided 
to make an apple script (like you described in your tutorial).

http://www.automaticduck.com/products/pifcp/
http://www.automaticduck.com/products/pifcp/


So I saved the script and went to FCP. Made a copy of one of the clips just for 
testing (because of the destructiveness of the scripts), and then send it to the 
apple script I saved. I did it once with the 'yes' and once with the 'no' button. In 
both cases it didn't work out. When I went back to FCP the audio was gone 
(completely deleted) except for one frame.

To be sure I didn't do anything wrong in this process I made another script in 
Soundtrack (normalization) and tried if that would work. That one worked fine.  
It looks like the delete audio action made in the spectrum window doesn't work as 
a script. 
 
Am I still doing something wrong or is this some kind of a bug. Do you have a 
solution or workaround for this?

Larry replies: Peter, this is a great question!

The problem with scripts is that they only process the entire clip - they don't understand 
selection. So, the script did not see "select this frequency range, then delete." Instead it just saw: 
"...delete."

I don't know of an easy way to clean up a selection of frequencies within your audio using the 
batch processing scripts in Soundtrack Pro.
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EXPORTING QUICKTIME FROM SOUNDTRACK PRO

Nicolas Nilsen writes:



Someone gave me a short QuickTime movie (.mov) with very bad sound. So I 
launched SoundTrack where the video appeared OK. I corrected the sound etc. 
And I exported (save as) as a QuickTime sequence... BUT the exported movie has 
no sound! I must be missing something ! What am I supposed to do ?

Larry replies: Nicolas, thanks for writing!

You made this question even more challenging by sending me a screen shot of the German 
version of STP! (It is hard enough for me to speak English clearly...)

I did a test to make sure of these steps. Here's what I did and everything worked.

1. Open the video clip in STP by dragging it on top of the STP icon in the doc. It 
automatically opens as an audio file project.

2. Make all necessary changes.

3. Normally, for a multitrack mix, you would Export. For an audio file project, you 
File > Save As. From the pop-up menu, be sure to change it from Audio File 
Project to QuickTime Movie. Also, the bit-depth needs to be 16-bit, and the 
sample rate should be 48,000 for all audio recorded with video.

4. Because audio editing in STP is non-destructive, you need to flatten the file; 
that is, you need to permanently change the file based on your modifications in 
order to save them properly into the QuickTime file. When this dialog appears, 
click Continue.

5. The QuickTime movie is saved.



6. Just to be sure, I opened the movie and verified (by typing Command+J) that 
the audio track was included and enabled, and that the audio played properly.

Everything worked fine.
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CREATING A DVD AUDIO DISC

Daniel Carrion writes:

I have a question that I think needs a special person to answer it…. 
 
I have an Acura TL that has a “DVD AUDIO” surround sound system. The issue is 
that there is not much in the market for this format. I took a look at one of these 
disks and noticed the format is the same as of a movie, but the AUDIO folder 
contains files. 
 
Can I create my own “DVD AUDIO” using FCP/STP?

Larry replies: Yes and no.

Yes, you can create the 5.1 surround mix in Soundtrack Pro. Yes, you can create a Dolby AC3 of 
that surround mix. However, what you can't, currently, do in Final Cut Studio is create the final 
format that needs to be burned to a digital audio disc. There may be third-party software out 
there that does this, but I don't know it.
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EXPORTING FOR A DVD

Kevin Stirling asks (and I'm paraphrasing his question here):

Larry, what's the best way to export a video from Final Cut for a DVD?

Larry replies: There are three possible ways to export your project:

�●     File > Export > QuickTime Conversion
�●     File > Export > Using Compressor
�●     File > Export > QuickTime Movie



QuickTime Conversion uses the codecs (compression software) that ships with QuickTime. 
While this isn't bad, it isn't the best either. QuickTime Conversion is neither particularly fast nor 
does it create particularly small file sizes. For this reason, I don't recommend it -- with ONE 
exception: creating H.264 movies.

Based on the testing I've done, creating H.264 movies using Compressor or using Export > 
QuickTime Conversion yields the same results -- provided you aren't doing any transcoding 
(converting from one video format, say HD, to another, like SD).

Using Compressor always takes longer than real-time. And, with one exception, yields the 
same quality as exporting as a QuickTime movie. Based on what I have been told, the benefit of 
going directly to Compressor is that if you have created a Motion project using 32-bit float space 
for your calculations, your Motion projects will look slighting better when you go directly into 
compression without first exporting.

However, if you create your Motion projects using the same video codec as your Final Cut 
project, you don't get this benefit. 

QuickTime Movie is both the fastest - always faster than real-time, assuming that all rendering 
is complete - and highest quality. For that reason, I recommend this option. Make sure Settings 
are set to Current Setting and you'll get quality equal to your video format for export.

By the way, there are two types of QuickTime movies:

�●     Reference
�●     Self-contained

A self-contained movie contains all your audio, fully mixed, all your render files and all your 
video files and collects them all into one gigantic file.

A reference movie contains all your audio, fully mixed, with pointers that POINT to all the render 
and video files on your system.

Reference movies export about 20 times faster than self-contained movies and are also about 20 
times smaller. If all you need to do is create a high-quality movie that you are immediately going 
to compress, a reference movie is perfect.

On the other hand, if you are going to:

�●     Send the file to someone else
�●     Keep the file on your system for a long period of time
�●     Work with GOP-based media (HDV or XDCAM)

then you will need to create self-contained QuickTime movies.

Here's an article that explains this further: http://www.larryjordan.biz/articles/lj_dvd_export.html

UPDATE - April 2, 2009 

Rick Lavon adds:

I think you forgot one crucial piece of info regarding the pros and cons of exporting 
thru QT, FCP and Compressor. With Compressor you can take advantage of the 
QMaster Cluster feature. My workflow has been to create a QT Reference movie, 
bring that into Compressor, and use the Cluster setting you can create thru the 
system preferences. 

http://www.larryjordan.biz/articles/lj_dvd_export.html


It's a fairly simple setup procedure yet the benefits are dramatic. This speeds up 
my encoding by almost 3x...not too shabby when you are encoding a DVD of a 1/2 
hour or more. The disadvantages of the other two methods are:

1) QT Export- you can't easily do batch encodings of multiple 
sequences 
2) FCP Export- You lock up your FCP system for the length of the 
encode.

Using Compressor frees you up to continue editing AND lets you do batch 
encoding. Heck, it'll even email you when it's done...

Larry replies: Rick, I am hearing a lot of complaints about QMaster recently and no longer 
recommend it for regular production. I am delighted this is working for you. 

[ Go to Top. ] 

UNDERSTANDING MORE ABOUT BLU-RAY

Markus Wernig sent this in:

I was inspired by your great Buzz Podcast on Blu-ray discs which you mentioned 
in your last newsletter. In that edition of The Buzz, Bruce said that with Toast 10 
you can burn a short Blu-ray project onto a traditional DVD-R. He also mentioned 
a "Toast Blu-ray tutorial" that he put up on Ken Stone's site: http://www.kenstone.
net/fcp_homepage/taming_the_wild_blu_2.html

I have a question that no one has been able to answer yet. I managed to burn a 
Toast Blu-ray-DVD-R but the menu that I picked didn't work at all. The screen just 
stays dark when I put the Blu-ray-DVD-R into my Blu-ray player. The only way I 
can get the Blu-ray movie to play is if turn on the auto-play option in Toast. When 
the movie is done playing, the screen goes black. No menu. If I want to play the 
movie again, I have to eject the disc and put it back in.

Bruce's tutorial makes it sound like the Blu-ray menus should work with regular 
DVD-Rs. Maybe someone can point me in the right direction. 

Larry replies: Currently, Blu-ray burning is a moving target. We should see some changes on this 
at NAB this year. However, I sent your questions over to my favorite Blu-ray expert - Bruce 
Nazarian - and he graciously sent me the following:

There are still a few glitches in the Toast world... I've encountered the bug where 
clicking the Menu button returns to a menu that is a black screen, with no BG 
image. I've reported this to Roxio and they're actively trying to solve it... seems it's 
only on some players, not others... there's no consistency in which Toast version 
or Mac OS triggers it, either... My experience has been that even if the menu is 
black, clicking the enter button should activate the button, and restart the movie. 
But the missing menu is a HUGE bug - and I've told Roxio about this. 

Also, this might be a similar issue what Markus reported, where the auto-loop 
function misfires, and loops a small section of the end of the film before it returns 
to the beginning of the movie. I suspect they have a few bugs yet remaining in 
Toast 10. 

http://www.digitalproductionbuzz.com/Archives/ShowNotes.php?date=2009-01-21
http://www.kenstone.net/fcp_homepage/taming_the_wild_blu_2.html
http://www.kenstone.net/fcp_homepage/taming_the_wild_blu_2.html


the Roxio forum is a good place to track the bug progress, or report it. 

The most recent Toast update - Toast 10 - seems to have fixed the loop bug, as 
the movie will now play and loop properly. However, the "menu doesn't show, only 
button highlight appears" bug still exists - Roxio have taken steps to investigate 
and finally squash this bug, but I can't say how long this will take.

By the way, Larry, in addition to my written tutorials on Ken Stone, I've been 
adding some new video tutorials on Recipe4DVD.com, in the Learn menu: "Learn 
Toast", and have begun a subscription newsletter series on Blu-ray, as well as 
updating issues on my Digital Guy blog. www.recipe4dvd.com/blog.

Larry adds: By the way, Bruce tells me that he will be making a MAJOR Blu-ray announcement 
at the Final Cut Pro SuperMeet at NAB in April. As soon as I can report it, I will.

[ Go to Top. ] 

MORE DVD PROBLEMS

Don writes:

I have just one other question about creating DVDs. I've included my sequence 
settings for you to see.

If i output this in QT using the current settings, use that file in DVDSP and create 
an DVD that is HD, the result is beautiful - very smooth transitions etc. but will not 
play on a standard DVD player. If instead I use it to create a DVD that is SD 

http://www.recipe4dvd.com/
http://www.recipe4dvd.com/blog
http://www.lafcpug.org/nab_2009.html


(setting attached), the result is far less quality, non smooth transitions etc.

I can understand the drop in quality from the HD version but I don't understand 
why the transitions, pans (on stills) are not smooth and why lines tend to "flicker". I 
had none of this in the HD version.

Plus if I take the same QT movie and create a DVD using iDVD instead of DVDSP 
using a 16:9 aspect ratio, the result is nearly as good as the HD version and plays 
on a standard DVD player. What is going on? I think my settings in DVDSP are not 
right but I don't know what to set them to to get a 16:9 ratio in SD so it will play in a 
regular DVD player. Do you know the default settings for iDVD? Possibly I could 
just mimic those in DVDSP?

Sorry for the long question but this is really the only problem I am having. Because 
of your training I can move through all the other aspects of FCP and DVDSP with 
no problems. I'm just not happy with the SD DVD produced from DVDSP. I thank 
you for your help.

Larry replies: Don, we have a number of problems here.

First, DVD SP does not do a good job of transcoding from HD to SD. You are MUCH better off 
compressing your video in Compressor. Apple has updated the compression engine in both 
iDVD and Compressor many times, while the compression inside DVD SP hasn't really changed 
for the last couple of years. At this point, I attribute the poor quality of your video to the poor 
compressor built into DVD Studio Pro.

Second, standard DVD players have no ability to play HD movies. That's what all the excitement 
of Blu-ray is about -- Blu-ray players can play both SD video and HD video, provided it is 
encoded and burned using the Blu-ray spec. DVD Studio Pro only supports the HD-DVD spec, 
which is no longer supported by anyone.

To create Blu-ray Discs on the Mac, you would need to use Adobe Encore or Roxio Toast. 

[ Go to Top. ] 



ANOTHER DVD QUESTION

Brian Pshyk asks:

I made a QT movie for iDVD (it up-scales nicely on a wide screen TV) and now 
would like to make a Letterbox version so I can offer the anamorphic (wide) 
version and a formatted for 4:3 version on the same DVD.

Larry replies: You can't get there from here. You'll need to create two sequences in Final Cut Pro 
- one 4:3 and the other 16:9.

Then, you'll need to create two tracks in DVD Studio Pro - again, one 4:3 and the other 16:9. 
DVD Studio Pro allows you to mix and match 4:3 and 16:9 tracks in the same project, but you 
can NOT mix and match different aspect ratios within the same track. 

Also, while not required, I would suggest creating all your menus at the same aspect ratio (4:3 or 
16:9) just to maintain a consistent look across your entire DVD.

[ Go to Top. ] 

USE JPEGs OR TIFFs?

Daniel writes:

I want to make a movie of my daughter’s wedding to give her as a memory/
present. All I have are JPG pictures (2304 x 1536). 
 
When you mention the benefits to work with uncompressed format (TIFF), does 
this mean to convert JPG to TIFF before going to FCP? Will I benefit (within FCP) 
in some form or shape with the conversion?

Larry replies: Thanks for writing, Daniel. I'm of two minds about this.

JPEGs are highly compressed, which means they often show blockiness or other image artifacts. 
However, they tend to have smaller file sizes. TIFFs are uncompressed with great image quality. 
However, their file sizes tend to be lots bigger. All things being equal, I'd use TIFFs. 

So, for me, this question is part image quality and part problem prevention.

Though your images are JPEGs, they are also large, which mitigates the artifacts in the JPEG 
compression as they get reduced for video. You can probably get away with using these JPEGs 
in Final Cut - it fully supports them. However, you may want to consider resizing them. I 
ALWAYS size my images properly, then convert them to TIFF before editing in Final Cut and 
have never had any problems.

Here's an article that explains more about this: http://www.larryjordan.biz/articles/lj_grfx_look.html

UPDATE - April 4, 2009

Eric Mittan adds:

Always keep in mind that while working with uncompressed picture files can make 
a better quality movie, it only makes a difference if you can have the original file 

http://www.larryjordan.biz/articles/lj_grfx_look.html


BEFORE being compressed to JPEG. If you have a JPEG file that shows the 
compression artifacts Larry mentions, simply converting THAT file to a TIFF will 
not get ride of those artifacts. 

Unless you are using a specific piece of software designed to, in some way, "up 
rez" your compressed still photos, moving to an uncompressed TIFF simply 
makes an almost exact copy of your compressed image and stores it in a much 
larger filesize.

Larry replies: Eric, a good point. Just as with video, once the image quality has been removed, 
changing the format won't make any difference. Thanks. 

[ Go to Top. ] 

INTERNAL VS EXTERNAL HARD DRIVES

Steve MacDonald sent me the following:

I was wondering if you could answer a hardware question? Is there any advantage 
in having your hard drives internal as opposed to external drives connected via 
firewire for editing in Final Cut Studio 2?

Larry replies: Steve, this is a good question. An internal hard drive will be faster than an external 
FireWire drive, but generally NOT as fast as an external SATA drive.

The big benefit to internal is that all your drives are in one unit.

The big benefit to external is that if there is a problem with the drive, you can get it repaired 
without losing access to your computer.
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GETTING SMOOTHCAM TO WORK FASTER

Bob Cusumano writes:

I recently shot a wedding for a friend and the clips were quite long as you can 
imagine. I made a bunch of sub clips for editing sanity. However, I came across 
this problem and I'm hoping you can help. I tried to apply the motion stabilizer to 
one of the subclips and instead of analyzing the subclip, FC started to look at the 
master clip. I double clicked on the subclip in the timeline to load it in the viewer 
and I loaded it in the viewer from the browser and got the same results. What am I 
doing wrong?

Larry replies: Bob, you didn't do anything wrong, but you are not playing into the strengths of 
Smoothcam. The Smoothcam (Motion Stabilizer) filter looks at the ENTIRE clip in order to work. 
Otherwise, you would need to reanalyze a clip every time you trimmed the In or the Out.

The best workaround when you want to stabilize a very short portion of a very long clip is to 
export just the portion of the clip you want to stabilize as a self-contained QuickTime movie, then 
reimport it into Final Cut. 



The only disadvantage to this approach is that creating a new QuickTime movie will change the 
timecode of the clip, which means that if you need to recapture it from the master source for 
some reason, you may have problems.

UPDATE - April 4, 2009

Eric Mittan adds:

While exporting a portion of the clip individually by setting an in and an out and 
using File > Export > Quicktime Movie will, in fact, change the timecode of the 
clip, there is a way for you to preserve your timecode (making it safe to recapture 
your footage if needed) while still making self-contained QuickTimes. 

Since you've already created subclips, highlight all of your subclips and choose 
File > Batch Export. In the Export Queue window that appears, choose the 
Settings button, choose a Destination for your new self-contained QuickTime 
movies, and make sure Make Self-Contained is checked. I also suggest clicking 
the "Set Naming Options…" button and making sure Add File Type Extension is 
checked. Click OK on the settings window and then click Export on the Export 
Queue. Your subclips will be exported as QuickTime Movies and timecode will be 
preserved! 

The one caveat I will point out using this method, is that if you happen to have 
long names for your clips, Final Cut may abbreviate the name of the resulting 
QuickTime movie and replace some of it with garbage, resulting in a file name like 
"Xmas Plants OSR_#B88800.mov". If this happens, I've also noticed that the 
timecode is NOT preserved and instead starts in that clip at 00:00 - just like using 
File>Export>QuickTime Movie.

But most importantly, a successful Batch Export means you'll be able to use 
Smoothcam on the resulting clips and they'll be analyzed much quicker.

Larry replies: Eric, thanks for taking the time to send this in. I don't use Batch Export, so I never 
think about it. I appreciate this detailed reponse. 
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IMPROVING QUALITY FROM RIPPED DVDS

Ellie Whitcomb writes:

I mostly edit sales reels for some shows that we sell. I get all different kinds of 
source material. Sometimes I’m lucky enough to have a master tape, sometimes I 
export the project myself from Final Cut, but mostly I deal with ripped DVDs. 
Probably, some of the older DVDs have undergone numerous rounds of 
compression. This is where my frustration comes in. 

I know once quality is lost, I’m never going to get it back, but what is more 
frustrating is I always end up with field issues. Lines in the video, or shifty 
transitions. And I can’t ever see these problems until I put my final edited DVD on 
a TV screen. I don’t see the problems when I play it on my computer. Is there any 
rule of thumb or manual that will help choose the correct export settings when I rip 
a DVD (I usually go through MPEG Streamclip)? When do I Deinterlace, how do I 
know whether to use Upper or Lower fields? Is it just trial and error?



Larry replies: Ellie, thanks for writing. All SD videos displayed on a TV - or burned to a DVD for 
that matter - are interlaced. Both NTSC and PAL are interlaced.

So, you don't want to deinterlace unless you are going to the web. This is because deinterlacing 
reduces the overall quality of the image.

NTSC and PAL video are both even (or lower) field dominant. This means that they display the 
even fields first, then the odd fields. 

Note: Here's an Apple tech support article that explains this in more detail: http://
support.apple.com/kb/TA26010?viewlocale=en_US

Complicating this is that unless you set Final Cut to display your video at EXACTLY 100% in 
either the Viewer or the Canvas, you will never see interlacing in Final Cut, as it only shows you 
one field at a time.

So, set your export settings to DV NTSC (or DV PAL), since DV has higher quality than the DVD 
does, with field dominance set to Even. Set NTSC frame rate to 29.97 fps and PAL frame rate to 
25 fps.

UPDATE - April 4, 2009

Eric Mittan adds:

Working in a newsroom where a portion of our archive video is stored as video 
DVDs, and where we're often using footage brought to us by the public on DVD, I'll 
agree with Larry that you shouldn't be deinterlacing your footage to go back out to 
DVD. 

The one exception I will make is that if you are doing anything with the geometry 
of your video in the Motion tab, you MAY need to deinterlace. If, for example, you 
move your center on the Y axis (this is the second number in the Center attribute 
in the Motion tab) anything other than a WHOLE, EVEN number, you should 
deinterlace, as you could potentially end up aligning the odd numbered fields of 
your source footage with the even numbered fields of your output footage, and the 
even numbered 
fields of your source with the odds of your output. 

Larry replies: Eric, I mostly agree. However, I don't think deinteracing should be the first choice. 
Instead, I strongly recommend that if you are compositing two interlaced images, both scaled to 
100%, you MUST make sure the Y value, circled in red below, is an even whole number.

http://support.apple.com/kb/TA26010?viewlocale=en_US
http://support.apple.com/kb/TA26010?viewlocale=en_US


Otherwise, the foreground image will become very soft and blurry. If you absolutely can't set the 
second value to an even, whole number, then deinterlace. 
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RETAINING CHAPTER MARKERS

Ben Balser writes:

I'm trying to export videos to H.264, or MPEG-4 Video, or some format for 
download, that will retain chapter markers. I can export my original DVCPRO-HD 
720 masters that retain chapter markers in QT Player. I can export for iPod with 
chapter markers, but the screen size is too small. 

Is there any listing that shows which codecs retain chapter markers from FCP and 
which don't? I'm running lots of tests right now, and the results don't always seem 
to be consistent, depending of it I export from FCP to self-contained QT, then 
recompress in QT Pro, or from FCP via Compressor.

Larry replies: Ben, this is a good question and I don't know the answer. If any reader does, 
please drop me an email.

UPDATE - April 2, 2009 

Zach Mull adds:

Regarding Ben Balser's question about chapter markers in H.264, I experimented 
for a minute and found a workaround, but I'm not sure if it has any bad side effects 
it causes. 

I can compress an H.264 file, bring that back into Final Cut Pro, edit it into a 
sequence and let FCP automatically adjust sequence settings to match the clip. 
Then I can add chapter markers, export it as a QuickTime movie, and and retain 
the chapter markers in QuickTime player. I don't believe that FCP has to 
recompress any of the frames if I don't apply filters or change anything in the 
motion tab, so I'm assuming there isn't any quality dropoff. I should note that 
bringing the clip back into FCP limits your audio options. 

I tried this with an H.264 QuickTime clip using AAC audio, and FCP brought it 
back to uncompressed PCM, I'm sure, since the file size increased significantly. 
So this method works, but I bet there's a way to add chapter markers directly in 
QuickTime Pro.

Larry replies: Zach, very cool! Thanks. 
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CAPTURING LIVE VIDEO

Ted Cumpston writes:

mailto:larry@larryjordan.biz?Subject=Chapter markers


I have a question for you to ponder. Our church is video taping our services. We 
want to be able to capture the video feed (SD) to a hard drive recording/playback 
device. Once captured, we then want to clean up the program in FCP and then 
transfer the edited program back to the drive for playback at another facility. So 
the question is, do you know of such a device that would allow this?

Larry replies: There are a number of products that do this. Here are three off the top of my head:

�●     Focus Enhancements makes the FireStore - a hard disk recorder.
�●     Final Cut allows you to capture a live camera using Capture Now.
�●     BlackMagic Design allows you to switch between two cameras and capture the switched 

feed.

As for transferring the edited version - the easiest way is to copy the finished, edited file back to 
your hard drive, or you could FTP the finished output to the receiving site. I regularly use 
Transmit as my FTP client. 

UPDATE - April 3, 2009

Andy Mees adds:

Regarding Ted Cumpston who asks about streamlining the post production for his 
church. I thought he might like to look at BoinxTV, quite a new software that may 
not be on everyone's radar quite yet. Could be quite suitable for his needs: http://
boinx.com/boinxtv/overview/ 

It works with any valid video input sources connected to his Mac.

( ... and hey, its worth a visit to the products webpages if only to marvel at the 
beauty of their website design!)

Larry replies: Andy, thanks for this.
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FEEDING VIDEO TO A MONITOR WALL

Yoni Goldstein writes:

First of all, thank you for your excellent newsletter. My question is about finding 
the best strategy for editing multi-channel video. That is, a piece that runs on two 
or more screens / projections simultaneously (and hopefully, in sync). My method 
so far has been to shrink each clip to 50% (by copying and pasting attributes) and 
move everything in V1 to the left of the frame and everything in V2 to the right. 
Unfortunately, because I use effects. I have to re-render everything and the 
process is rather slow.

Is there a better way to do this? Perhaps using the multiclip view? How do editors 
build sequences for those 2,3,4 screen displays at trade shows, for example?

Larry replies: The problem with your approach is that you are losing image quality when you 
shrink your image.

http://www.focusinfo.com/solutions/video_production.asp
http://www.apple.com/finalcutstudio
http://www.blackmagic-design.com/
http://www.panic.com/transmit/
http://boinx.com/boinxtv/overview/
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The way a monitor wall works is that you send it a full-screen feed for each camera or image you 
want it to display. It will then composite them into a single display. This gives you the highest 
image quality and the ability to zoom one of the images full-screen.

The only disadvantage to this is that you need four separate video sources that you can sync 
together. Currently, QuickTime only supports playback of one full-screen video image per 
computer. So you would need multiple computers, or tape decks, or DVD players, or... whatever.

UPDATE - April 2, 2009 

Tom Maynor adds:

I recently produced and displayed a 3-screen HD presentation for a trade show.

Multiscreener software (free at www.zachpoff.com/site/software/software.html) 
controls multiple Macs running QuickTime movies and keeps them in sync.

As the instructions pointed out I produced three same length videos in FCP and 
exported Quicktimes in Pro Res 422. I made them native to the display screen 
size of 1024x768. Running 3 mac pros (1 server and 2 clients) on a simple local 
network the 3 videos played nonstop for 3 days entirely in sync.

Yes, we had to rent the 3 macs in a faraway city but I am finding them more 
available and affordable and the video looked spectacular!

Larry replies: Tom, very cool! Thanks for letting me know. 
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FIXING A WHITE CANVAS

Daniel Milder writes:

I'm working on my very first project, very exciting. I shot an interview with a 
scientist. Made the narration track to tell the story I want, and now am covering the 
visuals. I realize that my Canvas goes to white whenever the playhead is paused. 
If I'm playing in the Timeline, or Viewer it stays white. I'm pretty sure it shouldn't be 
like that. I'm trying to do some motion effects and I can't see what I'm doing if the 
Canvas is like that. But I can't figure out how to make it stop. I've quit and 
restarted FCP but it always comes back that way.

Larry replies: Daniel, I enjoyed having you in my class.

http://www.zachpoff.com/site/software/software.html


The white background is caused by a setting in the Canvas. Go to the top of the Canvas and 
click the third pop-up menu to the right and change the setting from Alpha to RGB.
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THE CASE OF THE APPEARING AND DISAPPEARING FILES

Lionel C. writes from Brazil:

I started to edit the film on my G5. All files where captured and stocked on external 
disks. During the shooting, I was de-rushing and filing the clips on the ext. disks 
thru my MacBook Pro laptop. Now, I connected the disks to the G5 and I 
discovered that a lot of clips are missing... 

When I connect the external disks to the laptop again, all the files are there, when 
I connect them back to the G5, they disappear! And I can't find them on the disks. 

Also, when I move projects between computers, one of them says that it can't 
open the file because it was created with a more recent version of Final Cut!

Larry replies: Lionel, thanks for writing, it is good to hear from you again. Sounds like you did not 
set your scratch disks properly during capture.

If files appear on one computer, but not on another, it means that some files are stored on the 
first computer. To check, go to [Home directory] > Documents > Final Cut Pro Documents. 
Anything in the Capture Scratch folder in your Home Directory should move to your external 
drive.

Also, you can share files between FCP 6.0.3, 6.0.4 and 6.0.5 -- but nothing earlier. Your laptop is 
running 6.0.1 and your G-5 is running 6.0.3. Fortunately, upgrading 6.0.1 is free and available on-
line from Apple.

My recommended versions for the current Final Cut are 6.0.4, or 6.0.5.
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TRACKING MY TIME

Nicholas Bongianni writes:

I'm a long-time lover of your newsletter. Here's my quandary:

I'm getting tired of eyeballing time spent on clients' projects and giving them 
general time estimates of how long I've worked on their project. What I'd like to do 
is be able to tell them exactly how long I worked. I'm thinking of how chess players 
have their timer; push the button and your clock runs until you move, push the 
button and it stops.  
 
I'm wondering if anyone has developed an application that works like a stopwatch, 
but has a little more options. Specifically I often work on more than one client's 
project at a time, bouncing between FCP and say After Effects, it would be nice to 
track multiple projects at once, and if there were a way to qualify those chunks of 
time, categorize(capturing, rough cut, sound, color, graphics, etc.) well that would 
be just about perfect.

I imagine I'm not the only person out there that would see some sort of benefit in a 
product like this, or barring that, perhaps someone out there has got a solution 
that's so obvious it's no wonder I haven't thought of it by now already.

Larry replies: There are a number of applications like this out there - but I don't use any of them. 
Perhaps a reader can suggest a favorite.

UPDATE - April 2, 2009 

Tom Wolsky adds:

For tracking time, I've used TimeSlice for years and have been happy with its 
versitility. 

Larry replies: Thanks, Tom, I added a link to this as well. 

Micaajah Smithson adds:

I use TimeBanditX - it does everything that Nicholas wants to do - tracking time 
by client/ project/ function, and has a "time-out" function that watches mouse 
movements and stops timing the task based on your preferences. There's a try for 
free version and the full version is only $18.00

Here's the developers link: www.space-net.co.uk/projects.html

Larry replies: Thanks, I love choices! 
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A DIFFERENT WAY TO TRANSITION

Philip Roy writes:

http://www.timeslice.us/
http://www.space-net.co.uk/projects.html


This is Phil from Vermont. Every time your seminar comes to Boston I'm a 
heartbeat away from going until my wife pulls the plug. (She likes HELP with our 3 
kids, I guess) Great newsletter, I've told all my editing friends about it. 

I was wondering about custom transitions. Whenever I need something more than 
a page peel or cross fade, I look in the filters tab. I razor blade 10 frames on both 
sides of the cut, apply the filter to both new clips and then dig into the keyframes 
to set the filter from invisible to overblown, and then reversed on the next clip. 

Is there a faster way to do this? Better yet, a way to save these custom transitions, 
or at least the keyframing part?

Larry replies: Phil, remind your wife that your kids are always there, while my seminars only 
come around once a year. (Ah, I'm SURE that will work...)

As for saving your effect, grab the short clip that has your modified filter on it and drag it into the 
Browser. Then, when you want to apply the effect to a new clip:

�●     Select the clip in the Browser that has the effect you want to copy
�●     Choose Edit > Copy
�●     Select the clip you want to apply your settings to and choose Edit > Paste Attributes. 
�●     Check filters on and be sure the content checkbox is not checked.

Note: If the old and new clips are not the same length, the placement of 
keyframes will be adjusted based on the length of the new clip. If you don't want 
the keyframes to scale, uncheck Scale Attribute Times. 

UPDATE - April 3, 2009

Andy Mees sent in one more comment:



Shameless self promotion this one, but about creating and saving custom filter 
stacks as transition, I have a old blog post on exactly that subject. I'm not exactly a 
prolific blogger, but you might want to pass the link on to Philip ...  
web.me.com/andymees/Free_and_Easy/blog/Entries/2009/1/ 
29_Custom_Filter_Stacks_as_Transitions.html

Larry replies: Thanks, Andy. 

[ Go to Top. ] 

TROUBLE-SHOOTING MOTION

Mark Spencer, who runs the excellent website AppleMotion.net, sent me the following trouble-
shooting link for Apple Motion.

http://www.applemotion.net/Troubleshooting/Troubleshooting.html

By the way, if you are looking for trouble-shooting tips for Final Cut Pro, check out my own guide:

http://www.larryjordan.biz/articles/lj_trouble.html
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WORKING WITH MULTIPLE HD FORMATS

Sean writes:

Hey Larry, I just got footage from a music video that was shot with two different 
cameras (A2 and DVX 100b) - both using 60i. They also have some standard DV 
footage. I only have the DVX 100b as a deck. I was wondering what would be the 
best capture preset so I wouldn't lose any information, and what would be the best 
sequence preset, knowing that I will be importing the standard def? 

I have FCP6. There is no capture preset for 720 x 480 60i. I tried the different 
HDVs, but they would not recognize the camera, and I am afraid that DV NTSC 
might take away some of the quality from the 60i. Can you please recommend 
audio video settings? 

The only research specific to this camera I can find is 24p related, not 60i. I'm sure 
the solution is something simple, but it's my first time with 60i, and I want to make 
sure I can keep the better quality. 

Larry replies: HDV is High-def only. Neither the DVX-100 nor standard-def footage will capture 
with that setting.

If you shot HD on the A2, then you will lose resolution when you bring it into standard-def -- since 
HD and SD image sizes are not the same.

Your highest-quality SD preset is Uncompressed 10-bit. But DV doesn't have that kind of quality. 

http://web.me.com/andymees/Free_and_Easy/blog/Entries/2009/1/29_Custom_Filter_Stacks_as_Transitions.html
http://web.me.com/andymees/Free_and_Easy/blog/Entries/2009/1/29_Custom_Filter_Stacks_as_Transitions.html
http://www.applemotion.net/
http://www.applemotion.net/Troubleshooting/Troubleshooting.html
http://www.larryjordan.biz/articles/lj_trouble.html


So, if by 60i you mean high-def, then capture JUST the A2 camera using HDV 1080i/60. Then, 
change your sequence settings to DV NTSC to capture your SD footage. Then, edit everything in 
a single DV NTSC timeline. In doing so, however, you will lose all the additional image quality 
HD provides.

You can not switch between HD and SD quality in the same timeline. You can combine different 
formats on the same timeline, but they will all be rendered into the same format - either HD or SD.
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CAPTURING LARGE CHUNKS OF HDV

Anthony writes:

Can you help me with the following?

I have been using capture now in FCP DV format and it captures every thing OK. I 
switched to HDV and using capture now, it captures but it puts every thing in small 
packages. What can I do to set it to make it capture multiple shots in one segment?

I had a similar problem in DV and after I set limit capture now to 62 min it captured 
every thing OK.

Larry replies: Well, Anthony, as FCP moves to tapeless acquisition, it will capture each individual 
shot as a separate file. The days of capturing an entire tape as a single clip filled with different 
shots will disappear.

By default, HDV captures every shot as an individual clip. However, you can change this. In the 
Log and Capture window > Clip settings tab, uncheck the "Create new clip on Start/Stop" 
check box. Now, FCP will capture your HDV material as one long clip from In to Out.

Keep in mind, however, that if there is a timecode break, FCP will break the clip into separate 
clips -- and timecode in HDV is notoriously unreliable.

[ Go to Top. ] 



WHO IS LARRY JORDAN?

John Craske writes:

Given that I have been spending many hours in your company, I was curious to 
find out more about you. So I clicked on Wikipedia which said you had been a film-
maker since 1952. Which, if correct, means you've been doing it for 57 years. 
Hence I assumed that you'd now be well into your 70s.

Yet when you showed up on one of the Lynda training videos, you looked 
comparatively youthful. Certainly not someone who was in the twilight years.

How come? The only possibilities are that you have had some serious cosmetic 
work done, Wikipedia is wrong or I'm reading about a different Larry Jordan. 
Alternatively, you have applied some nifty video effects to enhance your 
appearance. The only other option I can think of is that you've quietly found the 
Secret of Eternal Youth.

Larry replies: Sigh.... If I HAD found the Fountain of Youth, why would I spend my time editing?

Actually, there are five Larry Jordan's working in media that I am often confused with:

�●     The Larry Jordan that started 2-POP and currently runs HDFilmTools. To reduce 
confusion, he's started calling himself Lawrence Jordan.

�●     The Larry Jordan based in the Bay area that creates high-end music videos for the likes 
of Maria Carey and many others.

�●     The Larry Jordan doing video production in Detroit.
�●     The Larry Jordan who is a long-time independent film director who's been working in films 

since 1952 (http://en.wikipedia.org/wiki/Larry_Jordan)
�●     And the Larry Jordan who is a male model doing advertising photo shoots around LA.

I am none of these fine folks. 
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WRAP-UP

Well, that's about it for this month. 

For current news and in-depth interviews on what's happening in our industry, be sure to listen to 
the Digital Production BuZZ every week.

�●     Please check out my latest video tutorials about HD . 
�●     Visit our store and buy something nice for yourself. 

In the meantime, please continue sending me your comments and questions. I love hearing from 
you and enjoy the conversations that develop around these stories.

Until next month, take care, and edit well.

Larry

http://hdfilmtools.com/
http://en.wikipedia.org/wiki/Larry_Jordan
http://www.digitalproductionbuzz.com/LiveThisWeek
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=110
http://www.larryjordan.biz/store
mailto:larry@larryjordan.biz?subject=Newsletter comments
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends 
to sign up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list 
is not sold, rented, or bartered. The only person who knows you are on this list is 
me.

The information in this newsletter is believed to be accurate at the time of 
publication. However, due to the variety of possible system and software 
configurations, the author assumes no liability in case things go wrong. Please use 
your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple or any other third party. 
All trademarks are the property of their respective owners and are mentioned here 
for editorial purposes only.

Text copyright 2009 by Larry Jordan & Associates, Inc. All rights reserved. This 
newsletter may not be reproduced or published in any way, in whole or in part, 
without specific written permission from the author. 

Links to my home page, blog, or website articles are welcome and don't require 
prior permission. 
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